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Exif Print
This printer supports Exif 2.2 (also called “Exif Print”).
Exif Print is a standard for enhancing the communication between digital cameras and printers. By 
connecting to an Exif Print-compliant digital camera, the camera’s image data at the time of shooting is 
used and optimized, yielding extremely high quality prints.

Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from a digital 
apparatus as set out in the interference- causing equipment standard entitled “Digital Apparatus,” 
ICES- 003 of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils 
numériques de Classe B prescrites dans la norme sur le matériel brouilleur NMB- 003 d'Industrie 
Canada intitulée « Appareils numériques ».

International ENERGY STAR® Program
As an ENERGY STAR Partner, Canon Inc. has determined that this product meets the ENERGY STAR 
guidelines for efficiency.

The International ENERGY STAR Office Equipment Program is a global program that  
promotes energy saving through the use of computer and other office equipment. The 
program backs the development and dissemination of products with functions that 
effectively reduce energy consumption. It is an open system in which business can 
participate voluntarily. The targeted products are office equipment such as computers, 
monitors, printers, faxes and copiers.
Their standards and logos are uniform among participating nations.

Power Requirements
Never use a power supply voltage other than that supplied in the country of purchase. Using the 
incorrect voltage could cause a fire or electric shock. The correct power supply voltages and frequencies 
are as follows:

AC 100-127 V, 50/60 Hz
AC 220-240 V, 50/60 Hz

Printer Model: K10205 (i6500/i6100)
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Preface
 Shipping Materials

Thank you for purchasing a Canon Bubble Jet Printer.
Check that all the following items are in the box. If anything is missing or is damaged, contact your Canon 
Authorized Dealer or Sales Representative.

Printer
Setup Software & User’s Guide CD-ROM
Quick Start Guide
Print Head
4 Ink Tanks

* Cables should be purchased separately according to your computer. For details on cable types and 
specifications, refer to page 2.

Introduction
This Quick Start Guide uses the following symbols to indicate important information.  Always observe the 
instructions indicated by these symbols.

Instructions that, if ignored, could result in death or serious personal injury caused by incorrect 
operation of the equipment.  These must be observed for safe operation.

Instructions that, if ignored, could result in personal injury or material damage caused by incorrect 
operation of the equipment.  These must be observed for safe operation.

Also read the Safety Precautions in the User’s Guide. Observe the warnings and cautions to avoid 
personal injury or damage to the printer.

Trademark Notices
• Canon® is a registered trademark of Canon Inc.
• BJ™ is a trademark of Canon Inc.
• Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the 

U.S. and other countries.
• Apple, Mac and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other 

countries.
• All other trademarks and registered trademarks appearing in this Quick Start Guide are the property of 

their respective owners.

Copyright ©2003 CANON INC.
All rights reserved. No part of this publication may be transmitted or copied in any form whatsoever 
without the express written permission.

Notice
The diagrams and computor screens in this guide refer to the i6500. The operations are exactly the same 
with i6100.
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Setting Up
1 Preparing the Printer

1111 Place the printer on a flat surface.

2222 Remove the tape from the printer as 
shown.

3333 Attach the paper rest to the sheet 
feeder.

4444 Open the output tray and remove the 
protective sheet and the tape.

2 Connecting the Printer to the Computer 
Use either a USB cable or parallel printer cable. You cannot connect the computer to the printer using both 
the parallel cable AND the USB cable.

output tray

paper rest

USB cable
• Windows XP, Windows Me, 

Windows 2000, Windows 98, 
• Mac OS 8.6 or later

Recommended: Canon or other computer 
manufacturer cable, up to 5 meters in length.

Printer cable (parallel)
• Windows NT 4.0, Windows 95

(Can also be used with Windows XP, 
Windows Me, Windows 2000 and 
Windows 98.)

Should conform with Centronics IEEE 1284 
and support bi-directional communication.
Recommended: Canon or other computer 
manufacturer cable, up to 2 meters in length.
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Follow the steps below to install the printer driver 
correctly.

1111 Ensure the printer and the computer are 
switched off.

2222 Connect the cable.
Figure A shows the USB cable connection and Figure B 
shows the printer cable (parallel) connection.

• The USB cable delivers relatively faster printing speeds and is recommended for use with 
Windows XP, Windows Me, Windows 2000 and Windows 98.

• If your computer has an earth connection, make sure that this is attached.
• If you do not intend to use the printer for a long period of time, unplug the power cord from the 

power outlet after turning off the printer.

Figure A

Figure B

If the Add New Hardware Wizard or Found New Hardware Wizard 
screen appears when carrying out the following operations, click 
Cancel and turn off the computer.
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3 Installing the Print Head

• Never attempt to plug the power cord into the power outlet or unplug the power cord when your 
hands are wet.

• Never damage, modify, stretch, or excessively bend or twist the power cord. Do not place heavy 
objects on the power cord.

• Never use any power supply other than the standard power supply available in the country of 
purchase. Using the incorrect voltage and frequency could cause a fire or electric shock.

• Always push the plug all the way into the power outlet.

Installing the Print Head
1111 Plug the printer in.

2222 Turn on the printer. Do NOT turn on the 
computer yet.
The POWER lamp flashes and the printer begins to 
operate. Wait until the POWER lamp remains fully lit.

3333 Open the front cover.

4444 Remove the tape and raise the lock 
lever.
Do not touch internal parts other than the lock lever.
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5555 Remove the protective cap from the 
print head.

6666 Place the print head in the holder.

7777 Lock the print head into place by 
lowering the lever.
Do not touch the lock lever once the print head has been 
installed.

Installing the Ink Tanks

• For safety reasons, store ink tanks out of the reach of small children.
• Do not drop or shake ink tanks.

1111 Take out the yellow ink tank.

2222 Pull the orange tape in the direction of 
the arrow and remove the clear film.

• Do not touch the print 
head nozzles or 
electrical contacts.

• Do not attempt to 
reattach the protective 
cap once it has been 
removed.

Be careful not to touch any parts inside the printer.

print head nozzles

print head

print head holder

electrical 
contacts
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3333 Hold the ink tank as shown in the 
diagram and remove the protective cap.

4444 Insert the yellow ink tank into the right-
hand slot. Press the top until it clicks 
into place.

5555 Use the same procedure to install the 
other ink tanks in their appropriate slots.
Check the labels to make sure that each tank is in the 
correct position.

6666 Close the front cover.
Wait until the POWER lamp remains fully lit (about 60 
seconds).

• Do not squeeze the sides of 
the ink tanks as this may 
cause the ink to leak out and 
stain your clothes and hands.

• Do not touch the ink port.
• Do not attempt to reattach the 

protective cap once it has 
been removed.

• Only install the ink tanks in the positions specified 
by the labels.

• If ink tanks are not installed in the right position, 
colors will not be printed correctly. Immediately 
reinstall the tank in the correct position and carry 
out print head cleaning. For details, refer to the 
User’s Guide.

Protective cap

ink port

Black Cyan Magenta Yellow
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4 Loading Paper

Loading A4 (Letter) Size Plain Paper
1111 Open the front cover.

2222 Move the paper thickness lever at the 
top of the print head holder to the left 
position. Close the front cover.

3333 Load the paper, aligning it with the right 
side of the sheet feeder.
You can load up to 100 sheets of plain paper. Do not 
exceed this limit.

4444 Press the paper guide and slide it 
against the left side of the stack of 
paper.

Set the paper thickness lever to the left when using 
plain paper, to the right when using thick paper. 
Refer to the User’s Guide for information on loading 
envelopes and other media.

Open the paper rest extension when printing on 
paper larger than A4. When printing on paper larger 
than B4, pull the output tray extension out one step 
beyond the position shown at left.

You now need to install the printer driver:
Windows: Go to page 8
Macintosh: Go to page 10

paper thickness lever

print side
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5 Installing the Printer Driver

Installing the Printer Driver – Windows

1111 Ensure the printer and computer are 
switched off.

2222 Turn on the computer and start 
Windows. If any applications 
automatically run, quit them.
Disable any virus detection programs.
Do NOT turn the printer on at this stage.

• Do not disconnect the cable or remove the CD-ROM during the installation. The driver cannot be 
correctly installed.

• The screens below refer to Windows XP installation. Screen may differ depending on the operating 
system you are using.

• When installing the printer driver in Windows XP, Windows 2000 or Windows NT 4.0, log on to 
the system as a member of the Administrators group.

If the following screen appears automatically, click Cancel and follow steps 1 to 7 to install the driver.

Special Notes for Windows Me or Windows 98 USB Users
Click Cancel to quit the screen and turn off the printer. Next, remove and replace the USB cable 
connected to your computer.

OFF
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3333 Place the Setup Software & User’s 
Guide CD-ROM in the CD-ROM drive.

4444 Follow the instructions displayed on 
screen. When the screen shown on the 
left is displayed, click Install.

5555 When the screen shown on the left 
appears, turn the printer on.
If the printer is recognized, the printer driver will be 
automatically installed.

6666 Click OK.
Before you can use the printer, you must carry out print 
head alignment on page 14.

• If the CD-ROM does not run automatically, click 
Start and My Computer, then double-click the 
CD-ROM icon. For non-XP Windows, double-
click My Computer in the Windows screen, then 
double-click the CD-ROM icon.

• If the language selection screen appears, select a 
language, then click the OK button.

If the connection is not recognized, refer to the 
section “Notes on Handling the USB Interface (for 
Windows Users)” on page 23.

ON
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7777 When the screen shown on the left 
appears, click Exit.

Installing the Printer Driver – Macintosh

For Mac OS 8.6-9.x Users

1111 Turn on the Mac.

2222 Place the Setup Software & User’s 
Guide CD-ROM in the CD-ROM drive.

3333 Double-click the Mac OS 8.6-9.x folder.

4444 Double-click the Printer Driver folder, 
then select a language.

5555 Double-click Installer.

6666 Read the Licence Agreement and click 
Accept to continue.

• To view the User’s Guide, please refer to page 23.
• If a message prompting you to restart the 

computer appears, click Yes.

• Do not remove or insert the USB cable during installation, as this may result in the computer or 
printer not operating correctly.

• Before installing the driver, disable all virus detection programs and automatically loading 
programs or remove them from your system folder.
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7777 Click Install.
Wait for the installation to finish.

8888 Click Restart.
The computer restarts.

9999 Select Chooser in the Apple Menu.

10101010 Click the icon for the printer you are 
using and close Chooser.

Before you use the printer, you must carry out print head 
alignment on page 16.

If the above message appears, check that there are 
no unsaved documents, then click the Continue 
button. If a document needs to be saved, click 
Cancel then save the document. After saving the 
document, begin again from Step 4.

Refer to the User’s Guide when using this printer as 
a network printer.
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For Mac OS X Users

1111 Turn on the Mac.

2222 Place the Setup Software & User’s 
Guide CD-ROM in the CD-ROM drive.

3333 Double-click the Mac OS X folder, then 
double-click the Printer Driver folder.

4444 Double-click i6500 180.pkg/i6100 
180.pkg.

5555 Enter an administrator name and a 
password, then click OK.

6666 Click Continue.
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7777 Read the License Agreement and click 
Continue, then click Agree.

8888 Select the Operating System to where 
you want to install the printer driver, and 
click Continue.

9999 Click Install.

10101010 A message asking for your confirmation 
to restart your computer appears on the 
screen. Read the message, then click 
Continue Installation.
Software installation will start.

11111111 Software installation is complete.
Restart your computer.
Before you use the printer, you must carry out print head 
alignment. For instructions on how to align the print 
head, refer to the Printer Driver Guide for Mac OS X. To 
view the Printer Driver Guide for Mac OS X, double-
click the Manual folder and Additional Guide for OSX 
User’s folder and select the language folder that you use 
as necessary.

You can also refer to the Printer Driver Guide for Mac 
OS X for instructions on how to use the printer driver.
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6 Aligning the Print Head
This operation must be carried out when using the printer for the first time. Aligning the print head positions 
allows you to print without shifts in the color registration.

Aligning the Print Head – Windows
1111 Click Start and select Control Panel, 

Printers and Other Hardware, and 
then Printers and Faxes.

2222 Click the icon for your printer.

3333 Open the File menu and select:
• Windows XP/Windows 2000 → [Printing 

Preferences...]
• Windows Me/Windows 98/Windows 95 → 

[Properties]
• Windows NT 4.0 → [Document Defaults...]

to open the setting screen.

4444 Click OK.

5555 Click the Maintenance tab, and click 
the Print Head Alignment icon.

6666 Check that paper is loaded in the printer 
and click OK. If a message warning you 
not to perform other operations 
appears, click OK.

For non-XP Windows, click Start, then select 
Settings, Printers.
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7777 After the pattern is printed, click Yes.
If the pattern is not printed successfully, open the front 
cover and ensure that the ink tanks are correctly 
installed.

8888 Look at the print-out. From the patterns 
in Column A, select the most even, least 
irregular pattern and enter the number.

9999 In the same way, one by one, select the 
most even patterns printed with the 
least irregularities from each of 
Columns B to F, enter their numbers, 
and click OK.
If it is difficult to pick the best pattern on Column F, pick 
the setting that produces the least noticeable vertical 
white stripes.

10101010 Click Cancel.
This completes the printer setup. The printer is now 
ready to use.

Click OK to perform even more detailed 
adjustments.
If streaks appear on the printed surface when you 
use the printer, follow the procedure below to adjust 
the printing.
(1) Check that the paper that you normally use is 

set in the printer, and then click OK. 
(2) Select the best patterns from Columns G and H, 

enter their numbers, then click OK.
The best patterns will be smooth and have no 
streaks in the border indicated by the arrows.

Less noticeable 
white stripes

More noticeable 
white stripes
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Aligning the Print Head – Macintosh
1111 Select Page Setup in the File menu.

2222 Click Utilities.

3333 Select Test Print from the menu and 
click the Print Head Alignment icon.

4444 Check that paper is loaded in the printer 
and click OK.
If the pattern is not printed successfully, open the front 
cover and ensure that the ink tanks are correctly 
installed.

5555 Look at the print-out. From the patterns 
in Column A, select the most even, least 
irregular pattern and enter the number.
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6666 In the same way, one by one, select the 
most even patterns printed with the 
least irregularities from each of 
Columns B to F, enter their numbers 
and click Send.
If it is difficult to pick the best pattern on Column F, pick 
the setting that produces the least noticeable vertical 
white stripes.

7777 Click Cancel.
This completes the printer setup. The printer is now 
ready to use.

8888 Click Close.

Click OK to perform even more detailed 
adjustments.
If streaks appear on the printed surface when you 
use the printer, follow the procedure below to adjust 
the printing.
(1) Check that the paper that you normally use is 

set in the printer, and then click OK. 
(2) Select the best patterns from Columns G and H, 

enter their numbers, then click Send.
The best patterns will be smooth and have no 
streaks in the border indicated by the arrows.

Less noticeable 
white stripes

More noticeable 
white stripes
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Basic Operations

• If you detect smoke, unusual smells or strange noises around the printer, immediately switch the 
printer off and always unplug the printer. Contact your local Canon service representative.

• To avoid injury, never put your hand or fingers inside the printer while it is printing.

Printing with Windows
Adjusting the print settings according to your needs allows you to produce better quality prints.
In this section, we will use WordPad for the purpose of explanation. The procedures you use and the screens 
that appear on your computer may differ according to the application that you use.

Printing
1111 Print the document from the application.

On the File menu, click Print.
Check the application’s users manual for the actual 
procedures.

2222 Ensure your printer is selected, then 
click:
• Windows XP → [Preferences]
• Windows Me/Windows 98/Windows NT 4.0/

Windows 95 → [Properties]
• Windows 2000 → [Main] tab

3333 Specify the required settings and click 
OK.

4444 To start printing, click Print.
Printing will start in a few moments.

If you use anything other than plain paper, please 
refer to “Basic Print Settings” on page 19.
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Basic Print Settings
For the best print quality, specify the minimum requirement settings in the Main tab. To get the best 
results, ensure you select the type of media loaded in the printer when printing on paper other than plain 
paper.

(1) Media Type Select the type of media loaded in the printer.

(2) Print Quality Select one option from High, Standard and Draft. Select Custom to 
set the print quality manually.

(3) Color Adjustment If you wish to control the color adjustment settings in more detail, 
select Manual.

(4) Preview before 
Printing

Select this to check the layout before printing.

(5) Help Click this for a more detailed explanation of the functions in the tab. 
(This may not appear when using Windows 2000 or Windows NT 4.0. 
If this happens, click Start then select Programs - Canon i6500/ 
Canon i6100- Guide).

(6) ? Click this to change the cursor shape to ?. By clicking on the item’s 
name with this ? cursor, an explanation will be displayed.

• Clicking the Print Advisor allows you to change to the most appropriate print settings simply by 
answering questions when prompted.

• Use the application to set the paper size and paper orientation. Before printing, open the settings 
screen and check that the Page Size in the Page Setup tab is the same as that specified within 
application.

• Refer to the User’s Guide for more information about printer driver functionality.

(6)

(1)

(2)

(3)

(5)

(4)
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Printing with Macintosh
Adjusting the print settings according to your needs allows you to produce better quality prints.

Printing
1111 Open the Page Setup dialog box in 

your application.
On the File menu, click Page Setup. Check the 
application’s users manual for the actual procedures.

2222 Specify the page setup.
For details, refer to “Page Setup” on page 21.

3333 Open the Print dialog box in your 
application to print the document.
On the File menu, click Print. Check the application’s 
users manual for the actual procedures.

4444 Specify the print settings according to 
your requirements.
For details, refer to “Basic Print Settings” on page 21.

5555 Click the Print button.
Printing will start in a few moments.
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Page Setup
Use the Page Setup dialog box to specify the paper size settings.

Basic Print Settings
For the best print quality, specify the minimum requirement settings in the Print dialog box. To get the 
best results, ensure you select the type of media loaded in the printer when printing on paper other than 
plain paper.

(1) Media Type Select the type of media loaded in the printer.

(2) Print Mode Select the type of document you want to print. 
To specify more detailed settings for the print quality or color, select 
Manual and click Details.

(3) Print Click this to start printing.

• See Balloon Help for more information about other printer driver functions.
Select Show Balloons in the Help menu for an explanation of each of the items in the setting 
screen. To see the explanation, point to the item with the mouse.

• Refer to the User’s Guide for more information about printer driver functionality.

Select paper 
size you 
wish to use.

(1)

(2)

(3)
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Print Head Maintenance

If Blurring Occurs or If a Specific Color Does Not Print
Perform print head cleaning to improve the print quality. Ensure that the printer is turned on and follow 
the instructions below.

• Windows
Open the printer driver settings screen and click the Maintenance tab. Click the Cleaning icon.
See page 14 for details on how to open the setting screen.

• Macintosh
Open the Page Setup dialog box and click the Utilities button. Click the Cleaning icon.

When the Printer Runs out of Ink
Replace the empty ink tank with a new one.
Specify the following ink tanks when purchasing.

Yellow BCI-3eY
Magenta BCI-3eM
Cyan BCI-3eC
Black BCI-3eBK

1111 Open the front cover and remove the 
empty ink tank.
Do not touch the lock lever.

2222 Install the new ink tank.
Close the front cover when finished.

For more details about maintenance, refer to the 
User’s Guide.

lock lever
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Notes on Handling the USB Interface (for Windows Users)
If installation of the printer driver does not proceed as instructed in this Quick Start Guide, there may be a 
problem with the USB driver installation.
Try reinstalling the printer driver.

Reinstalling
If you cannot proceed beyond the Printer Port screen:

1111 Click Cancel.
2222 When the Terminate Installation 

screen is displayed, click OK.
3333 Click Exit, then remove the 

CD-ROM.
4444 Turn the printer off.
5555 Restart the computer. 

6666 Reinstall the printer driver (see page 8). 

For Further Details...
For more information, place the Setup Software & User’s Guide CD-ROM in the CD-ROM drive.

User’s Guide Contents
The “User’s Guide” is HTML manual you can browse through on your computer.

How to View the User’s Guide

Contents

• Printer parts and their functions
• Printer driver functions
• Routine maintenance

• Printing media
• Troubleshooting
• Specifications

For Windows
(1) Load the CD-ROM in your computer.
(2) Click Documentation on the left of the screen.
(3) Click View Documents.
(4) When a message appears, click

Yes-to install the User’s Guide
No-only to browse the User’s Guide

(5) Select User’s Guide and click OK.
Follow the instructions on screen.

For Macintosh
(1) Load the CD-ROM in your computer.
(2) Double-click the Manual folder.
(3) Double-click the Manual folder.
(4) Double-click the User’s Guide folder.
(5) Select a language folder.
(6) Double-click the icon for the 

i6500_UG_ENG.htm /i6100_UG_ENG.htm 
file.
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BJ Printer Driver Systems Requirements
For Windows
• Use a computer on which Windows XP, Windows 2000, Windows Me, Windows 98, Windows 

NT 4.0 or Windows 95 can operate.
• USB* interface or standard 25 pin parallel interface
• Available hard-disk space for printer driver installation

Windows XP/Windows 2000/Windows NT 4.0: 50MB
Windows Me/Windows 98/Windows 95: 15MB

* USB operation can only be guaranteed on a PC with pre-installed Windows XP, Windows 
2000, Windows Me, or Windows 98. (This includes Windows XP, Windows 2000 or Windows 
Me upgraded from pre-installed Windows 98 or later)

For Macintosh
(Macintosh 8.6-9.x)

• Use a Macintosh series computer equipped with USB interface on which Mac OS 8.6-9.x can 
operate.

• 30MB of available hard-disk space for printer driver installation

(Macintosh OS X)

• Use a Macintosh series computer equipped with USB interface on which Mac OS v10.2.1 or 
later can operate.

• 100MB of available hard-disk space for printer driver installation.
• The following functions are not supported:

- Duplex Printing
- Photo Optimizer PRO

• If you want to use an application, first install the application contained in the Mac OS X folder. 

Additional Systems Requirements for User’s Guide
• Pentium® 75 MHz equivalent or higher processor (Pentium® 133MHz equivalent or higher 

processor recommended)
• 2x or higher CD-ROM drive (4x or higher recommended)
• 10 MB of available hard-disk space (when installing the User’s Guide)
• Microsoft Internet Explorer 5.0 or later
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Exif Print
This printer supports Exif 2.2 (also called “Exif Print”).
Exif Print is a standard for enhancing the communication between digital cameras and printers. By 
connecting to an Exif Print-compliant digital camera, the camera’s image data at the time of shooting is 
used and optimized, yielding extremely high quality prints.

Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from a digital 
apparatus as set out in the interference- causing equipment standard entitled “Digital Apparatus,” 
ICES- 003 of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils 
numériques de Classe B prescrites dans la norme sur le matériel brouilleur NMB- 003 d'Industrie 
Canada intitulée « Appareils numériques ».

International ENERGY STAR® Program
As an ENERGY STAR Partner, Canon Inc. has determined that this product meets the ENERGY STAR 
guidelines for efficiency.

The International ENERGY STAR Office Equipment Program is a global program that  
promotes energy saving through the use of computer and other office equipment. The 
program backs the development and dissemination of products with functions that 
effectively reduce energy consumption. It is an open system in which business can 
participate voluntarily. The targeted products are office equipment such as computers, 
monitors, printers, faxes and copiers.
Their standards and logos are uniform among participating nations.

Power Requirements
Never use a power supply voltage other than that supplied in the country of purchase. Using the 
incorrect voltage could cause a fire or electric shock. The correct power supply voltages and frequencies 
are as follows:

AC 100-127 V, 50/60 Hz
AC 220-240 V, 50/60 Hz

Printer Model: K10205 (i6500/i6100)
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